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Introduction 
 
This manual describes the function and operation of the GeoVista data acquisition and 
replay software.  All the necessary functions are described allowing the user to learn 
the operation of the software. 
 

GeoVista Platform Logger (GVPL) Short Cut keys 
 
The software has a set of icons which allow rapid access to the most commonly used 
functions,  and are referenced throughout the text of this manual.  The short cut icons 
are; 
 

 
 
The function of these icons is indicated below each icon.  Other short cut keys are 
 

Short Cut key Function 
F1 Open new logging file 
F2 Open file for replay 
F3 Edit standard header 
F4 Edit existing header 
F5 Select sonde stack 
F6 Open winch control panel 
F7 Open sonde diagnostic panel 
F8 Toggle sonde power 

 
In addition, each of these functions is selectable from the top menu in the usual way.  
In this manual,  selection of functions is normally described by reference to the menus 
rather than the icon,  so the sonde power function would be described as  
System->Sonde Power 

Add A Sonde Serial Number 
 
The GeoVista Platform Logger Software (GVPL) is aware of the sondes that are 
owned in a particular location.  A list of these sondes,  and their serial number, is held 
within the GVPL database files. 
 
If the user wishes to add a sonde to the GVPL installation then a simple procedure 
needs to be followed.  These steps are as follows 
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From the top menu select Select->Add Sonde Serial Number.  The screen will 
appear as; 
 

 
 
 
Here the user has scrolled down the scroll box labeled “Sonde Types Registered” to 
locate the name of the new sonde,  TCME,  and has entered the serial number of the 
sonde into the box labeled “Enter Serial Number”,  in this case the serial number is 
1553. 
 
When Accept Sonde is pressed,  the GVPL will update the database files and the 
sonde will be available for use in a stack. 
 
When a new sonde is purchased,  then a calibration file will be made available with 
the sonde.  For the system to correctly calibrate the sonde data then this calibration 
file must be correctly located into the directory c:\gvsystem.  Copy the supplied 
calibration file into this directory. 
 
The calibration filename is created in a special way. So that the system can correctly 
determine which calibration file to apply.  For example,  with the sonde being 
registered above,  the calibration file name will be 
 
TCME1553.CAL 
 
Clearly,  the filename is a concatenation of the sonde name (TCME in this case) and 
the sonde serial number (1553 in this case).  The file extension is always CAL. 
 
So,  if the system is made aware of the sonde name and serial number the calibration 
filename can be constructed by the GVPL and applied to locate the correct calibration 
file. 

Possible problems With Add Sonde Serial Number 
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It is possible that when scrolling down to locate the name of the new sonde from the 
list that it cannot be located.  The reason for this is that the files GV_SONDE.INI and 
GV1SONDE.INI,  both located in directory c:\gvsystem,  are out of date.   
 
If this occurs then check carefully on the supplied disc that there is not a new copy 
available. If there are new copies available then copy these into the directory 
c:\gvsystem.  It is a good precaution to make copies of the old files before they are 
overwritten.  
 
If new copies of these files are not available then please contact GeoVista for further 
assistance. 
 

Build A Stack 
 
Before the sondes can be operated,  then it is necessary to build a stack.  This is the 
method by which the GVPL is informed of the combination of sondes that are to be 
run,  which serial numbers are to be used and in which sequence the sondes are to be 
connected. 
 
To activate this procedure,  Select Sonde->Build Stack from the top menu.  The 
screen will appear as; 
 

 

Select Number Of Sondes 
 
The first task is to tell the system how many sondes are to be in this stack,  and this is 
achieved by selecting a value between 1 and 5 in the “Select Number Of Sondes In 
Stack” selection box.  In the example shown,  the user has selected three. 
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On making this selection, the display in the adjacent window will change to show 
placeholders for the number of  sondes selected to be in this stack. 

Select Sonde Types & Serial Number 
 
In the window labeled “Stack Diagram”,  locate the scroll boxes under the label 
“Sonde Type”.  Starting with the top box,  which will be the sonde at the top of the 
stack or the shallowest sonde,  select the sonde name required.  In this case the user 
has selected “ELOG” as the top sonde. 
 
In the scroll box to the right of the sonde selected,  another selection box appears 
under the column labeled “Serial #”.  When opened,  this will display a list of sonde 
serial numbers of type “ELOG” that are registered with the system.  Select the 
required serial number. 
 
Repeat this process for the other two sondes.  In the example shown the user has 
selected the stack: 
 
ELOG Serial number 1087 
NGRS Serial number 1085 
TCME Serial number 1142 
 

Apply Stack Description 
 
In the window labeled “Stack Description”,  the user can enter free text that will be a 
useful reminder of the sondes in the stack that has been defined.  
 
There are no restrictions of required format for this text,  the GVPL does not use this 
data in any way,  it is simply displayed when the user selects a stack in future.  For 
example,  the text “BLUE Stack” has been included and reflects the use of colour 
coded stacks in some locations.   
 

Saving The Stack Definition 
 
When the appropriate data has been entered, press the button labelled “Save Stack 
Definition” and the stack definition will be saved to the system database. 
 
Pressing “Cancel” at any time will exit the screen and discard any data that has been 
entered. 
 
Possible Problems With Building A Stack 
 
When trying to locate the sonde name required in the “Sonde Type” selection box,  
the required name may not appear.  The reason for this is that the sonde type has not 
been registered.  Perform the procedure detailed in the section “Add A Sonde Serial 
Number”. 
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Similarly,  if the sonde type can be located but the required sonde serial number is not 
present in the “Serial #” selection box,  perform the procedure detailed in the section 
“Add A Sonde Serial Number”. 
 

Select A Stack 
 
Prior to testing a stack or starting logging,  then the GVPL needs to be informed of the 
stack,  which is to be run.  This is achieved by selecting Sonde-> Select Stack from 
the top menu.  The screen will appear as below; 
 

 
 

Screen Shot:  Selection Of Stack 
 
Note that this is a common operation,  a shortcut key has been made available,  and is 
high lighted in the picture above.  Simply clicking on this will show the stack select 
screen. 
 
In the selection box all the stacks that have been built on this system will appear,  and 
the user selects the required stack. Here the stack built in the previous section has 
been selected.  
 
Note that the sonde serial numbers are as entered before and the comments that were 
entered have also appeared. 
 
After displaying the appropriate stack, click on “Accept Stack Selection” and the 
screen will close with the correct stack selected. 
 
The button labelled “Accept Last Stack Used” is also available,  and simply selects 
the last stack that was selected.  This is provided as a convenience to speed operations 
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Problems That Can Occur With Stack Selection. 
 
Any problems that occur here will be related to an error on one of these files; 
 
GV_SONDE.INI 
GV1SONDE.INI 
GV_STACK.INI 
 
If problems occur then reinstall these files from the distribution discs.  Reloading 
GV_STACK.INI will cause any recently built stacks to be lost so it is best to copy 
GV_SONDE.INI & GV1SONDE.INI first to see if this clears the problem. 
 

Sonde Diagnostic Data Display 
 

Powering The Sonde Stack 
 
At this point,  the following steps will have been performed; 
 

1 The required sondes will have been added to the sonde database 
2 The required stack will have been built 
3 The required stack will have been selected 
4 The sonde stack will have been connected to the winch and the logging box 

correctly connected. 
 
The next step is to apply power to the sonde stack.  This is achieved by selecting from 
the top menu System->Sonde Power.  This will send a command from the GVPL to 
the logger box,  which then applies sonde power to the sondes. 
 
Note that,  as switching sonde power is a common function,  there are three methods 
of switching the sonde power on and off.  The menu selection System->Sonde Power 
is probably the least convenient. 
 
Pressing F8 on the keyboard will toggle the power supply,  so that if the sonde power 
is on,  it will switch off when F8 is pressed and vice versa. 
 
Clicking on the short cut key with the yellow “lightning strike” at the top of the tool 
bar short cut band (see Screen Shot:  Selection Of Stack above) will also switch on 
and off the sonde power supply. 
 
The logger box measures the sonde power supply voltage and current and reports 
these values back to the GVPL for display.  These are displayed in the top left hand 
corner of the screen display,  and are reproduced below enlarged for clarity. 
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Screen Shot:  Sonde Power Supply & Battery Display 
 
Here,  the sonde is taking a current of 52milliAmperes,  and the voltage applied is 
68VDC.  Note that the voltage measured is the voltage at the surface,  and will be 
lower at the cable head as there will be a voltage drop across the logging cable. 
 
Also measured is the power supply to the logger.  This is nominal 12VDC,  but 
satisfactory operation down to 10.5VDC can be achieved. 
 

Selecting Diagnostic Display 
 
Now the sondes are powered,  the diagnostic panel can be entered to ensure correct 
operation of the sondes prior to logging.  This is not an essential step,  but it is highly 
recommended. 
 
Again,  because this is a common operation,  there are three methods of displaying the 
diagnostic panel.  Each will achieve the same result,  but some are more convenient 
that others depending on circumstances.  The three methods are; 
 

1 Select System->Diagnostic from the top menu. 
2 Press F7 on the keyboard 
3 Click on the icon with the spanner display on the top tool bar short cut band 

 
The display will now appear as in the screen shot below. 
 
 
There are several areas of interest here,  and they will be discussed separately. 
 

The Data Quality Report 
 
The window,  coloured green in this display,  indicates the quality of the telemetry 
coming from the sonde.  Each data packet from the sonde has error checking data 
attached to it,  and this enables the GVPL to determine if an error has occurred.  If an 
error is detected then the green dot will be replaced by a red dot,  and the data packet 
discarded. 
 
A count of good and bad packets is maintained in the windows labelled “Bad Packets” 
and “Good Packets”.  These are for the user to monitor.  These values can be reset by 
clicking on “Reset Counters”.   
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Screen Shot  Diagnostic Data Display 
 
The data in these windows is for the users information only,  no use of made of this 
data by the system. 
 
On a system in good condition,  there should be no red packets although an occasional 
red packet can be expected in an electrically noisy environment.  As the GVPL 
discards any bad packets,  their presence will not cause an error in the recorded data. 
 
In the event that red packets become significantly more in number,  then this is an 
indication that a problem is developing and corrective action should be taken before 
the situation becomes critical. 
 

Select Cable Length 
 
The surface logger box has an amplifier to amplify the digital telemetry signal from 
the sonde,  and the gain of this amplifier can be used to select high gain (for longer 
cables) or low gain(for shorter cables).  In fact,  the telemetry is quite tolerant of cable 
length and the telemetry will be good (all green packets) on either setting.  If,  during 
a logging operation,  red packets become more frequent then it may be possible to 
save the situation by increasing the gain. 
 

Timebase 
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Normally,  users require borehole logs to be referenced against depth,  and this is what 
the GeoVista logging system produces.  On the other hand,  the cable communications 
protocol is time based.  What this means is that once the stack in use has been 
declared and logging is started,  the stack is addressed on a timebase.  Each sonde is 
addressed in turn at a regular interval.  The frequency with which the stack is 
interrogated is variable,  under user control, at rates of 10,  20 or 40 samples per 
second.   
 
What this means is that if 4 sondes are in the stack and the highest sample rate of 40 
samples per second is chosen,  then each sonde will be interrogated 10 times per 
second.  To relate this to depth,  this will give a sample from each sonde for each 
centimeter of borehole traveled if the logging speed is 6 metres per minute. 
 
If only 2 sondes were in the stack,  then 1 centimeter sampling would be achieved at 
12 metres per minute.  
 
The sample rate is set by the options available in the “Timebase” section.  The values 
available are as in the table below. 
 
Timebase Selection Samples per second 
100 milliseconds 10 
50 milliseconds 20 
25 milliseconds 40 
 
 
 
The user should decide on what vertical resolution is required and the number of 
sondes in the stack and what logging speed should be used. If unsure,  use 25 
milliseconds.  The only downside of this is that the data files will be larger. 
 

Calibration 
 
As discussed previously,  each sonde has an associated calibration file which converts 
the raw data from the sonde into the required engineering units.  When the check box 
labelled  “Calibration” is checked,  then these calibration coefficients will be applied 
and the data displayed will be in engineering units.  When the “Calibration” box is 
unchecked,  then the data display will be raw data as received directly from the sonde. 
 

Average 
 
When the “Average” checkbox is checked,  then data from the sonde will be 
accumulated over the period starting when the box is checked,  and the data displayed 
will be the average value over that interval.  This is useful with radiation sondes. 
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Select Sonde For Display 
 
In the diagnostic data display,  the data for the ELOG sonde is displayed.  The 
complete stack comprises three sondes,  as seen in the stack information window (see 
next section).  To display the data from other sondes in the stack,  select the sonde 
from the selection box labelled “Select Sonde For Display”. 
 
All the sondes in the stack will be displayed and can be selected for display as is the 
ELOG in the example. 
 

Stack Information Window. 
 
In the top center of the screen is the stack information window,  shown below 
enlarged for clarity. 
 

 

Screen Shot  Stack Information Window 
 
 
There are two lines of information here,  the upper line displays the currently selected 
log file name (none selected as yet in the above example) and the lower line shows the 
names of the sondes selected and the total sonde length.  This useful in setting the 
sonde depth in the borehole,  and will be referenced later. 
 

Select A Log File For Data Recording 
 
Prior to logging,  the user must specify the name of the log file where data will be 
stored.  Entry to the logging mode is prohibited until a filename has been entered by 
the user.  This operation is initiated by pressing the icon showed on the screen below. 
 
The shortcut icon is indicated,  and after this the usual Windows file naming 
procedures are followed.  The ability to navigate directories and create new directories 
exists at this level. 
 
Enter the new filename in the location as indicated.  If the filename entered already 
exists the user will be warned of this and the creation of a new file will be disallowed.  
This prevents overwriting existing data in error. 
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After successful creation of the new file,  the stack information window will be 
updated as below. 
 

 
 
 

Starting To Record Data 
 
There are several options when recording data,  some are cosmetic and some are 
essential that they are correct.   
 
Log Direction 
 
Firstly,  the log direction must be set correctly.  There are three modes of logging,  
these being Log Up, Log Down and Log Time.  Most services are recorded in either 
log up or log down,  although log time has some applications. 
 
On the top bar of the GVPL screen,  locate the drop down box as shown below. 
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Here,  the drop down box has been activated,  and the three options are displayed.  
Select the log direction required and the selected mode will be displayed.  It will not 
change unless the user selects a different mode. 
 
 

Sample Interval Selection 
 
The selection of the sample interval is a cosmetic selection,  in that the value selected 
here does not influence in any way the data that is acquired from the sondes and 
recorded to disc.  On replay,  the user has all options available independent of the 
value chosen during logging. 
 
What is does do is control how much of the logged interval is displayed on the screen 
while logging.  Usually,  a value of 10cm gives the best display,  and is a good 
starting point.  The user may modify the value chosen in light of practical results. 
 
The selection is made by the drop down box shown below. 
 

 
 
 

English & Metric Depth Systems 
 
The GVPL can operate in either English (Feet) or Metric (metres) depth systems.  If 
the English mode has been selected then the sample intervals available will be in 
inches.  All other comments for the metric system apply. 
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Starting Logging 
 
When logging is initiated,  the following steps,  all of which have been described so 
far,  should have been performed; 
 

1 Assembly of the sondes required 
2 Selection of the appropriate stack 
3 Powering the sondes and checking that the data is correct 
4 Selection of a log file name 
5 Selection of the log direction mode 
6 Selection of the sampling interval 

 
 
When these steps have been performed,  logging is initiated by pressing the “Start 
Log” icon (this is the icon on the top row with the red circle).   
 
When the sondes are pulled uphole (log up was selected) then the display will be as 
follows. 
 

Discussion Of Displayed Screen 
 
One of the special features of the GVPL is that the performance of the whole system 
is monitored,  and made available to the user while logging.  Some of these points are 
brought out here. 

Display Of Diagnostic Data While Logging 
 
The first thing to notice is that the operator has also opened the diagnostic screen and 
resized the display to show both the diagnostic data and the logged data 
simultaneously.  This is a powerful and useful feature of the GVPL system,  it allows 
all available data to be displayed to ensure data quality.   
 
For example,  if cable head problems were developing then this may well be displayed 
as red packets.  The user would be aware of this and could take corrective action,  for 
example increase the telemetry amplifier gain,  or perhaps choose to pullout and 
check the cable. 
 

Sonde Power & Battery Condition Display 
 
Here the sonde current is displayed,  again allowing the user full knowledge of what is 
happening with the sondes. 
 
The battery supply to the logger is also displayed,  allowing more information to be 
used as a system diagnostic. 
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Screen While Logging Up With Diagnostic Panel Displayed 
 

Display Of Depth And cable Speed With Optional tension 
 
The display above shows the sonde depth and cable speed.  This is essential 
information.  Also available when used with a GeoVista winch system is the cable 
tension.  The example above does not have this option. 
 

Replay Of Logged Data 
 
The replay function of the GVPL allows the following features; 
 

Display Of Logged Data 
 
To view the logged data on the screen,  select the File->Open replay File and select 
the log file name as required.  The screen will now look like this; 
 
 
 
 
 
 
 



GeoVista Platform Logger Software manual 
Page 18 Of 55.  Version 7.4 

 
 

 
 

Screen Display Of Temperature-Inclinometer Log 
 
These are numerous options and controls here,  and a brief description will be given.  
The best method of understanding the operation is to get a sample log and try the 
different options. 
 

Curve Ident On Each Page 
 
This allows the appearance or suppression of the curve description on each page.  
Useful when continuous stationery is used in the printer. 
 

Deepest & Shallowest Depths 
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The user has the option to display & print out a selected interval by entering the depth 
limits in these boxes.  The actual log file limits are displayed in another pair of boxes 
which cannot be edited. 
 

Full Depth Range 
 
Pressing this simply resets the log depth file limits to the full extent of the logged 
interval. 
 

Plot To Printer 
 
This initiates the log to be plotted to the selected printer.   
 

Footer On Each Page 
 
This causes the log file name to be printed at the bottom of each page of the printed 
log. 
 
Brief header On. 
 
This causes the printing of the brief header.  This comprises the title line from the 
header file to be written to the printer prior to the plotting of the log.  This is a 
shortened version of the main header and is useful for field prints.   
 
The font for this printout can be selected from System->Brief Header Font. 
 

Vertical Scale 
 
This allows control of the vertical scale for the print out and the screen display.   
 
Some printers do not print exactly the correct vertical length of paper,  which can be a 
problem for log correlation.  The solution to this is to select System->Printer vertical 
Scale and enter the appropriate correction. 
 

LAS File Options 
 
To export the logged data to other software packages,  for example Viewlog or 
Wellcad,  the data needs to be presented in a suitable format.  The format chosen is 
the LAS (Log Ascii Standard).  The options here allow control of the exported data. 
 
Note that only GeoVista software can read directly the recorded data files, the 
translation to LAS is required for all other software packages. 
 
There are options available for the LAS translation.  These are the inclusion of the  
Recorded cable tension (when fitted) and the sonde power during logging.   
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In the event that a user curve has been included,  then this data can also be exported. 
 
Selecting the “Displayed Data Only” box will cause only the curves actually 
displayed on the replay log screen to be output to the LAS file.   If not clicked,  then 
all the curves in the log file will be exported. 
 
On GVPL version 5.80 & later,  the ability to export sonic full wave data as a 
<>.WAF file is available.  In the “LAS File Options” frame,  the options FWS5 and 
FWS3 will appear when a sonic log is replayed.  Clicking either of these before 
creating the LAS file will cause the creation of two files in the same directory as the 
LAS file.  If the name given for the LAS file,  was for example,  “myfile”,  then the 
two extra files (if both options were selected) will be 
 
Myfile_3FT.WAF  and  Myfile_5FT.WAF 
 
These are Ascii files which can be read into WellCAD using the file import routines.  
Once imported into WellCAD then the built in sonic processing options can be used. 
 
 
On GVPL version 5.84 & later,  further options are available.  These are selected from 
the LAS File Options,  as seen below. 
 

 
 
When a full wave sonic record is detected in the data file,  then the extra options to the 
right of the option box will appear.  Selecting either,  or both as shown,  of FWS5 and 
FWS3,  will allow export in a format usable to other packages.  Ticking the WellCAD 
box will export the <>.WAF file as described above.  Ticking the ViewLog box will 
export the files in the SEG2 format.  This format can be read both by WellCAD and 
ViewLog. 
 
The files created will be,  from an input file of myfile,  myfile_3FT.SG2 and 
myfile_5FT.SG2.  They will be created in the same directory as the LAS file. 
 
Version 6.34 & later rationalized the full wave sonic export into a single SEG2 
output.  This is an international standard that is supported by numerous commercially 
available packages. 
 
Note that if a Windows association is setup,  the double clicking on either a <>.HDR 
or <>.RDF file will start a new copy of the GV Platform Logger (version 6.34 & 
greater) and enter the replay screen automatically.  
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GV Platform Logger version 6.45 and later now have a facility to associate header file 
entries with specific fields in the LAS file.  This allows the creation of header 
templates in the importing software to automatically associate header entries in the 
GV header file and the headers created in the importing software. 
 
This is achieved by editing the GV_HEAD.INI file.  An example of this file is shown 
here. 
 
[Header Description] 
Number Of Entries=1 
Entry 1=GeoVista 
 
[GeoVista] 
Number Of Fields=33 
Logo=C:\vb_proj\Q_Log\GVLog2.bmp 
Entry 0=SERVICE COMPANY/,/Induction/,/ 
Entry 1=COMPANY/,/BLS Logging/,/ 
Entry 2=COUNTRY/,/Jordan/,/ 
Entry 3=PROVINCE/,/Conwy/,/ 
Entry 4=WELL/,/KZRC_0616_1/,/ 
Entry 5=FIELD/,/Burton/,/ 
Entry 6=LOCATION/,/In The Truck/,/ 
Entry 7=STATE/,/Cheshire/,/ 
Entry 8=COUNTY/,/England/,/ 
Entry 9=LATITUDE/,/1234/,/ 
Entry 10=LONGITUDE/,/5678/,/ 
Entry 11=ELEVATION/,/10 metres/,/ 
Entry 12=PERM. DATUM/,/GL/,/ 
Entry 13=DATE/,/09/05/10/,/ 
Entry 14=SALINITY/,/NaCl/,/ 
Entry 15=RUN NUMBER/,/1/,/ 
Entry 16=DEPTH DRILLER/,/300/,/ 
Entry 17=DEPTH LOGGER/,/299/,/ 
Entry 18=TYPE OF FLUID/,/water/,/ 
Entry 19=DENSITY/,/1.0/,/ 
Entry 20=VISCOSITY/,/3/,/ 
Entry 21=END CIRC./,/1980/,/ 
Entry 22=UNIT NUMBER/,/1/,/ 
Entry 23=RIG NUMBER/,/2/,/ 
Entry 24=oh-csg 1/,/30 meters/,/ 
Entry 25=oh-csg 2/,/40 metres/,/ 
Entry 26=oh-csg 3/,/50 metres/,/ 
Entry 27=oh/,/60 metres/,/ 
Entry 28=remarqs/,/Warm day/,/ 
Entry 29=RECORDED BY/,/MP/,/ 
Entry 30=Start time/,/0900/,/ 
Entry 31=End time/,/1100/,/ 
Entry 32=WITNESSED BY/,/Local People/,/ 
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[mnemonic] 
mnemonic 0=/SRVC./ 
mnemonic 1=/COMP./ 
mnemonic 2=/CTRY./ 
mnemonic 3=/PROV./ 
mnemonic 4=/WELL./ 
mnemonic 5=/FLD./ 
mnemonic 6=/LOC./ 
mnemonic 7=/STAT./ 
mnemonic 8=/CNTY./ 
mnemonic 9=/LATI./ 
mnemonic 10=/LONG./ 
mnemonic 11=/ELEV./ 
mnemonic 12=/PERM./ 
mnemonic 13=/DATE./ 
mnemonic 14=/SALI./ 
mnemonic 15=/RUN./ 
mnemonic 16=/OTHER./ 
mnemonic 17=/DEPT./ 
mnemonic 18=/TYPE./ 
mnemonic 19=/DENS./ 
 
Note that the first part of this file is edited using the usual GV header editor.  The user 
must enter the section below the keyword [mnemonic].  The correlation between the 
two sections is the Entry number and the mnemonic number.  For example,  Entry 15 
Run  Number will be exported into the LAS file with the mnemonic RUN. 
 
Using the sample file,  then the Well Information section of the LAS file will be as 
below. 
 
 
#------------------------------------------------ 
~Well Information Section 
#MNEM.UNIT        VALUE.NAME                     DESCRIPTION 
#------------------------------------------------ 
STRT.M   973.72                                   :START DEPTH 
STOP.M   880.00                                   :STOP DEPTH 
STEP.M   -0.01                                    :STEP 
NULL.    -999.25                                  :NULL VALUE 
SRVC.    Induction                                :SERVICE COMPANY 
COMP.    BLS Logging                              :COMPANY 
CTRY.    England                                   :COUNTRY 
PROV.    Conwy                                    :PROVINCE 
WELL.    ABC_0616_1                              :WELL 
FLD.     Burton                                    :FIELD 
LOC.     In The Truck                             :LOCATION 
STAT.    Cheshire                                 :STATE 
CNTY.    England                                  :COUNTY 
LATI.    1234                                      :LATITUDE 
LONG.    5678                                     :LONGITUDE 
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ELEV.    10 metres                                :ELEVATION 
PERM.    GL                                        :PERM. DATUM 
DATE.    09/05/10                                 :DATE 
SALI.    NaCl                                      :SALINITY 
RUN.     1                                         :RUN NUMBER 
OTHER.   300                                      :DEPTH DRILLER 
DEPT.    299                                       :DEPTH LOGGER 
TYPE.    water                                     :TYPE OF FLUID 
DENS.    1.0                                       :DENSITY 
VISC.    3                                         :VISCOSITY 
OTHER.   1980                                     :END CIRC. 
OTHER.   1                                         :UNIT NUMBER 
OTHER.   2                                         :RIG NUMBER 
OTHER.   30 meters                                :oh-csg 1 
OTHER.   40 metres                                :oh-csg 2 
OTHER.   50 metres                                :oh-csg 3 
OTHER.   60 metres                                :oh 
OTHER.   Log started Wednesday, Mar 23 2011  15:4: 
OTHER.   MP                                       :RECORDED BY 
OTHER.   0900                                     :Start time 
OTHER.   1100                                     :End time 
OTHER.   Local People                             :WITNESSED BY 
UWI.     0000     :UNIQUE WELL ID 
 
When creating the [mnemonic] section of the GV_HEAD.INI file take care to respect 
the layout otherwise the results may not be as excpected. 

Automatic LAS File Generation. 
 
With version GV Platform Logger Version 6.34 & later,  it is possible to have the 
LAS file generated  immediately on stopping the logging process. 
 
To achieve this,  there is a set of options accessed by the File->Setup LAS Output 
from the top menu.  The screen displayed is shown here; 
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The function of these boxes is; 
 
Generate LAS Automatically After Logging 
 When ticked,  the LAS file will be generated as the Stop Log button is pressed. 
 
Displayed Data Only 
 When ticked,  only curves on log display will be exported to the LAS file 
 
SEG2 Sonic Export 
 
  When ticked the creation of SEG2 files will be created.  Note that this 
is only operational with sondes with mnemonic ASNC,CBLS and SNIC.    Also the 
adjacent drop down box allows the selection of 5cm or 10cm sampling interval for 
these files. 
 
Computed Curves 
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 When ticked,  and computed curves present will be exported to the LAS file. 
 
Cable Speed 
 When ticked,  the cable speed during logging will be exported to the LAS file. 
 
Cable Tension 
 When ticked,  the cable tension during logging will be exported to the LAS 
file. 
 
Cable Speed 
 When ticked,  the cable speed during logging will be exported to the LAS file. 
 
Sonde Power 
 When ticked,  the sonde stack power (Voltage & Current) during logging will 
be exported to the LAS file. 
 
Logger Supply 
 When ticked,  the logger power supply voltage during logging will be exported 
to the LAS file. 
 
Regular Log Sample Interval 
 
Here the user has the option to select 1cm,  5cm or 10cm sample interval for the LAS 
file depth column. 
 
 
The output LAS file will be stored in the same location as selected during for the log 
raw data files,  and have the same name.  The file extension will be LAS. 
 
For the sonic files the files generated will be as follows 
 
Sonde mnemonic  
ASNC <>_RX1TX1_2FT.SG2 

<>_RX2TX1_3_3FT.SG2 
<>_RX3TX1_5_1FT.SG2 
 

CBLS <>_RX1TX1_3Ft.SG2 
<>_RX2TX1_5Ft.SG2 
 

SNIC <>_RX1TX1_3FT.SG2 
<>_RX2TX1_5FT.SG2 
<>_RX2TX2_3FT.SG2 
<>_RX1TX2_5FT.SG2 

 
Where <> represents the originally selected path for the recorded data.  Note that the 
spacing is embedded in the extended file name. 
 
The LAS file generation options selected are stored in the GV_SYS.INI file and will 
be recalled each time the software is started. 



GeoVista Platform Logger Software manual 
Page 26 Of 55.  Version 7.4 

Editing Curve Presentation  
 
During both logging and replay,  it is possible to modify the curve presentation.  In 
both scenarios the method is the same. 
 
To initiate the curve editor,  double click on the log display area and the “Edit Curve 
Appearance” dialog box will appear as below. 

 
 

Edit Curve Dialog 
 
 

Selection Of Sonde 
 
In a stack system,  there may be several sondes.  Select the sonde which is required to 
be edited from the drop down box.  In the sample shown the NGRS (gamma sonde) is 
shown selected. 
 
Selecting the different sondes in the stack will automatically display the appropriate 
channel names and units for the selected sonde. 
 

Curve Position On The Log display 
 
The usual log grid is divided into three tracks,  termed Track1,  Track2 and Track3 as 
seen below. 
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A curve has a LH (Left hand) position and a RH (Right hand) position,  and these 
values are chosen from the drop down menu as seen in the edit curve dialog.  Using 
these positions,  a curve can be placed over a single track or over two or more tracks.  
Curves can be placed over the depth track,  if required.  Many possibilities are 
available and the user should investigate these. 
 

Curve Display Values 
 
The user can enter the LH and RH curve values to suit the application.  There is 
complete flexibility in the values that can be applied. 
 
In the event that the data value goes above the RH value set (or below the LH value 
set) then automatic curve wrap will occur. 
 

Curve Display On And Off 
 
The CURVE drop down box will allow the curve to be turned off from the display 
(select the “OFF” option) or have a number from 1 to 4 assigned to the curve. 
 
In logging,  the value of this number has no effect.  During replay (both to the screen 
and the printer) it is used to thicken the lines of the trace.  This is useful for different 
printers and to distinguish between different traces on monochrome printers. 
 

Filter Width 
 
The filter width control allows smoothing of data to suit the type of data being 
recorded.  For example,  the gamma data requires a filter of typically 17,  where as the 
temperature curve does not require a filter width. 
 

Trace Colour 
 
The colour of each trace can be individually set by selecting the colour option.  This 
feature is used to distinguish between different curves placed in the same track. 
 

Saving Of The Curve Parameters 
 
If,  during a logging session,  the user modifies the curve parameters,  a prompt will 
be raised asking if these options  
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Answering “Yes” to this will save the modified presentation into the log file header 
and into the system database files.  The saving of the parameters in this way ensures 
that after one operation the required local format will be written to the sonde database 
and automatically used for each new log.  This feature allows adoption of local log 
presentation standards with minimal effort. 
 

 

Header Editor 
 
 
It is required to record textual information about the circumstances of the logging 
operation,  and present this information in the form of a printed log header.  The 
GeoVista system allows the creation of a user defined log header and the editing of 
this header 

The Standard header 
 
The system has a standard header stored in the database,  and  this is used as the 
template for the headers that the user will create and print out with the log. 
 
Selection of  System->Edit Standard Header will open this standard header or 
template,  and allow the user to edit the contents.   
 
When the user later creates a new log file,  a new header is automatically created.  The 
contents of this newly created header (which will have the same name as the log file,  
but with a different extension) will be copied from the standard header.  To later edit a 
created header (rather than the standard header) requires the selection of  
System->Edit Existing Header. 
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Sample Of Header 
 

Editing The Header Entries 
 
The text in blue is the data that the user normally modifies,  and this is what will be 
printed onto the log at print time.  Note that a logo has been included in the top right 
hand corner.  The user can create a logo personalized to their system by scanning in 
their logo and creating a bitmap image.  Double clicking on the logo area will allow 
the location and inclusion of the bitmap image. 
 
Some experimentation may be required to get the printout to be a satisfactory size. 
 

Editing The Header Fixed text 
 
The user may also modify the text which appears in black in the above example.  This 
is done by double clicking on the text field of interest.  A dialog box will appear 
allowing entry of the new text.  
 
This allows both personalization and changing to different languages. 
 

Recommendations On Use Of Headers 
 
The best method of handling the headers is to follow these steps; 
 
On a new system.   
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1 create the logo for the users organization and check that it prints out well on 
the chosen printer. 

2 Edit the fixed header text on the standard header to reflect local needs and 
save these to the standard header. 

 
When on logging jobs 
 

1 Before the first run,  enter all the available data to the standard header so that 
this data will be automatically copied to headers as they are created during the 
logging operation. 

2 Add new information as it becomes available,  editing the previously recorded 
headers as necessary. 

3 Make sure that the headers are correctly filled in.  It may seem unnecessary 
bureaucracy at the time,  but can prove vital at a later date. 

 
 

Log Disclaimer 
 
On GVPL Version 5.2 and later,  an option exists to optionally include a disclaimer on 
the header print out.  This disclaimer is stored in the GV_HEAD.INI file,  and may be 
edited by the user.  The standard text, in the format seen in GV_HEAD.INI, is; 
 
 
[Disclaimer] 
Line 1= Company Disclaimer 
Line 2= All interpretations are opinions based on inferences from electrical 
Line 3= or other measurements. The Company does not guarantee the correctness 
Line 4= of these interpretations.  The company shall not be 
Line 5= responsible for any loss, however incurred, in the use of these inferences. 
 
 

Sonde Data Calibration 
 
The sondes often produce data which needs conversion from raw data to engineering 
units.  For example,  a caliper sonde produces a number which is proportional to the 
borehole diameter.  To display this in mm or inches requires calibration coefficients to 
be applied. 
 
The GVPL  allows the user to both create calibration files for the sondes and to apply 
these calibration coefficients during logging. 
 
The starting point to create a calibration file for a sonde is to build the sonde into a 
stack and enter the diagnostic screen,  as described in previous sections of this 
manual.  When displaying the sonde for which calibration is required,  locate the 
channel name that is to be calibrated and place the cursor over the name.  Now press 
the right mouse button and this screen will appear. 
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Calibration Screen For A 2 Arm caliper 
 
Actually,  the screen shown is at the final stage of the calibration process.  When the 
screen loads,  the 3 boxes for “calibration value” and “Data value” will be empty. 
 

Number Of Calibration Points 
 
The software will apply an equation to the data in the form of equation (1) or equation 
(2); 
 

)1.........(....................10 alueSondeDataVAAdatacalibrated •+=  
 
 

)2......(* 2
210 alueSondeDataVAalueSondeDataVAAdatacalibrated +•+=  

 
Equation (1) is a 2 point straight line calibration,  so if this is required the option “2 
Point Calibration” should be selected.   
 
Equation (2) is requires a 3 point non linear calibration,  so if this is required the 
option “3 Point Calibration” should be selected.   
 
The number of boxes available for data entry will change to reflect the number of 
points chosen here. 
 

Averaging Period For The Calibration 
 
When calibration is started,  the system will accumulate data for a period which is 
selectable at values of  5, 20 or 100 seconds.  For radioactive sondes,  such as gamma 



GeoVista Platform Logger Software manual 
Page 32 Of 55.  Version 7.4 

sondes,  the 100 second interval should be selected.  For most sondes,  the averaging 
period of 5 seconds is adequate. 
 
Select the period required by clicking the appropriate checkbox. 
 

Density Sonde Calibration 
 
This selection is for calibrated density sondes,  and is dealt with in a supplementary 
manual.  Do not select either of these options unless a density sonde is being 
calibrated. 
 

Starting The Calibration 
 
When the correct number of points and the correct averaging period is selected,  place 
the sonde in the first calibration fixture.  In this example,  the caliper should be placed 
in the 100mm position of the calibration jig. 
 
When ready,  press “Start Cal 1”.  The system will accumulate the data for the 
selected averaging period and display the result in the “Data value” box adjacent to 
the “Calibration value”. 
 
Repeat this process for the three calibration points chosen.  After the completion of 
the third calibration point (or the second if a two point calibration had been chosen) 
then the “Calculate” button will appear. 
 

Graphical Display Of The Calibration. 
 
Press the “Calculate” button and the graph of the three (or two) calibration points will 
be drawn as shown.  Most sonde responses are close to linear,  and the deviation from 
linearity can be seen here in the example. 
 
It is important to observe the graphical representation,  as any errors in the procedure 
may be evident from this display.   
 
 
 
 
 
 
 
 
 
 
In the example here,  the result is almost certainly wrong and the reasons for this 
should be investigated.  The example shown in “Calibration Screen For A 2 Arm 
caliper” above is reasonable and can be accepted. 
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Saving Calibration Data To File 
 
After the “Calculate” stage and the plotting of the graph,  the “Save” button can be 
pressed.  This will save the calibration data to the appropriate file. 
 
The calibration data will be added to the file whose name is the concatenation of the 
sonde mnemonic and the sonde serial number with the extension .CAL.  So,  if this 
caliper (CALX) were serial number 1502 the calibration file name would be 
CALX1502.CAL.  These calibration files are always stored in c:\gvsystem. 
 

Winch Parameters 
 
The winch is an integral part of the logging system as it contains the depth measuring 
system and the cable tension measuring system.  Both these parameters need 
calibration,  and GVPL provides the software routines to achieve this calibration. 
 
To gain access to these facilities,  select System->Winch control Panel and the 
screen will appear. 
 
The functions in this screen are boxed together logically,  and will be discussed 
separately. 
 

Depth System Parameters 
 

Winch version 
The winch version is the version of the firmware running in the GeoVista logger and 
cannot be modified by the user. 
 

Tension Units Kgs or Lbs 
 
When a GeoVista winch with cable tension gauge installed is used,  then the units for 
the display can be selected as either kilograms or pounds.  The user should select the 
unit they feel most comfortable with.  The selection has no impact on other parts of 
the system software. 
 
 

Depth Units-feet Or Metres 
 
The GVPL can operate in either Feet or Metres for the depth system.  The user can 
select here which is required.  Changing from one system is accomplished by simply 
selecting here,  the GVPL will automatically change all the necessary conversion 
parameters. 
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Winch Control Panel 
 

 

 

Reverse SE Sense 
 
If it is found that the depth decreases when the sondes are lowered downhole,  then 
this can be reversed by changing the status of the checkbox  here.  On some systems,  
it is necessary to change the checkbox then press “Apply Parameters” and then reboot 
the GVPL software. 

Measure Wheel Circumference & Depth Pulses Per Revolution 
 
These are the characteristics of the depth system on the winch.   
 
The logger counts the pulses from the shaft encoder mounted on the winch,  taking 
account of the direction of rotation,  and computes the depth from this number and the 
circumference of the measure wheel. 
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In the GeoVista system,  both PPREV and Circ can be modified by the user.  The 
ability to change the PPREV allows flexibility in interfacing to winches manufactured 
by other manufacturers,  as does the ability to change the value of Circ.  
 
Also the ability to modify Circ allows depth wheel wear to be compensated for. 
 
The units for Circ are those selected in the adjacent selection panel i.e. feet or metres. 
 
There is an automated process for calibrating the depth system,  dealt with in the next 
section. 
 

Depth System calibration 
 
The depth system comprises a measure wheel which turns when the cable passes over 
it.  The measure wheel is coupled to a shaft encoder which produces the pulses as the 
wheel turns. 
 
To calibrate the system,  only the wheel rolling circumference value is required as the 
encoder number of pulses per revolution is fixed and known. 
 
Calibration of the depth system is as follows; 
 

1 Setup the winch and mark out a length of cable as accurately as possible,  
mark the measured distance with tape on the cable.  The length of cable should 
be as long as practical.  10 metres should be considered a minimum for 
accurate results. 

2 Pull the mark on the cable to a fixed reference mark and stop the winch. 
3 Set the depth system to a positive value greater than the length of cable that 

will be pulled through the depth measure wheel (say,  200 metres) 
4 Enter the length of cable that will be pulled through the depth system into the 

box Depth System Calibration>Enter Depth Interval. 
5 Now press Depth System Calibration>Start.  The text in this button will 

change to “Got nnnnnn”,  where “nnnnnn” is the current count of the depth 
encoder pulses. 

6 Now pull the cable through the depth measure system,  ensuring that some 
tension is kept on the cable so no slippage occurs. 
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7 When the second tape mark reaches the reference point,  stop the winch.  Do 
not overrun the reference and reverse the direction,  as this will cause errors.  
If the reference is overrun then start again from step 2. 

8 When stopped at the second reference,  press Depth System Calibration>Stop.  
The text in this button will change to “End nnnnnn”,  again displaying the 
shaft encoder count. 

9 Now press Depth System Calibration>Apply.  The system will then compute 
the new measure wheel rolling circumference and display it in Depth system 
Parameters>Measure Wheel Circumference. 

10 Check that the new value is reasonable (GeoVista winches are typically 0.4 
metres circumference) and when satisfied,  press Depth System 
Parameters>Apply Parameters.  This will load the new value into the system 
files and hardware. 

 

Set Depth 
 
Entering a value into Set Depth Value>Set depth  and pressing Set Depth 
Value>Apply Set Depth will set the depth value.   
 
There is another method of setting the system depth which is more convenient. 
 
On the top screen,  hold down the shift key on the keyboard and click the mouse 
anywhere in the lower part of the screen below the tool bars.  This display will then 
appear. 
 
In the window,  the present depth will be displayed.  The functions available are as 
follows; 
 
 

 
 

Increase 
This will increase the depth display by 0.01 metres each time it is clicked. 
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Decrease 
This will decrease the depth display by 0.01 metres each time it is clicked. 
 

Set Depth 
 
Enter a depth into the window and press Set Depth will write the value to the depth 
display. 
 

Zero The Depth 
 
This will zero the displayed depth. 
 

Set Stack Length 
 
This checkbox will only appear if a stack has been selected.  Checking this box will 
transfer the stack length into the window,  and then press Set Depth lo set this as the 
system depth.  The value of this is if the top of the sonde stack has been set to the 
depth reference,  then the correct depth for tool zero is the stack length,  or the bottom 
of the stack. 
 

Auto Depth generation 
 
This facility is available to assist in sonde checking,  and allows for the generation of 
depth events without turning the winch. 
 
To activate,  click on Auto Depth Generation>Auto Depth On\Off and select the 
required direction by selecting Direction>Up or Direction>Down.  The speed of the 
simulated depth can be controlled by moving the slider in the same panel. 
 

Cable Tension System calibration. 
 
The cable tension signal is reported to the GVPL as a raw value,  and calibrated in the 
software.  This raw data value is displayed in the window “Tension Bit Value” as seen 
in the winch control panel screen.  
 
To calibrate the system,  follow this procedure 
 
 

1 Ensure that the correct tension units have been selected. 
2 Setup the winch so two different weights can be conveniently attached to the 

cable.  Choose two weights suitable for the winch and cable in use,  
representing typically the range of tensions to be expected in operation. 
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3 Attach the lighter of the weights,  and enter the value of the weight into the 
“Enter Low tension” box.  Now lift up the weight slowly,  and while in motion 
press the gauge icon adjacent to the “Enter Low tension” box.  An elapsed 
time bar will appear for a few seconds. 

4 Now attach the heavier weight,  entering the weight into the “Enter High 
Tension” box.  Lift up the weight again and press the icon adjacent to the 
“Enter High Tension” box. 

5 On completion,  the “Apply Calibration” button will become available.  Press 
this to calculate the new tension gauge calibrations.  The calibration will now 
be stored. 

6 Check that the displayed tension is correct.  Change back to the lighter of the 
weights and ensure that the correct reading is obtained. 

 
The calibration coefficients are stored in the logger box,  and also in one of the system 
database files.  These coefficients can be retrieved from the system file by simply 
pressing the “Load From Sys File” without going through the procedure described 
above. 
 

Cable Tension Alarm 
 
During logging operations,  the operator should keep a close watch on the cable 
tension display.  Either over tension (sondes stuck logging up) or under tension 
(sondes hang up while going down) can lead to problems. 
 
On GVPL version 6.55 and later what is conventionally termed a differential tension 
display is available.  A more accurate description would be a delta tension display.  
 
This display is reset by the user by double clicking the display of differential tension.  
A sample is shown here. 
 

 
 
When the operator resets the differential tension display,  the software will store the 
current value of the cable tension.  As the cable tension increases,  then the green bar 
as shown will move towards the right.  If the cable tension decreases then the display 
will move towards the left,  and will be drawn in red.  Thus the user will have a quick 
visual indication of which way the tension is changing. 
 
Clicking the “Differential Tension Reset” will return the display to the centre. 
 
To activate this display,  an entry in the c:\gvsystem\gv_sys.ini file is required.  Open 
this with notepad and add this section at the end of the file; 
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[Tension Alarm] 
CommPort= 12 
Span_0=5 
Span_1=10 
Span_2=20 
Span_3=30 
Span_4=40 
Visual Display=On 
Audio Alarm=On 
Span= 10 
Reset Value= 10 
 
Note that the “Span” entries represent the total span of the differential display.  These 
values can be changed by the user.  While running,  using the mouse to “right click” 
the differential tension display the different span selections can be made. 
 
An audible alarm unit can be purchased from GeoVista that alerts the operator when 
the differential tension display gets to either the maximum or minimum end of the 
display.  This unit simply plugs into a spare USB port on the logging computer. 
 

Tools Menu 
 
The GVPL software allows some log file manipulation functions which can be useful.  
These are accessed from the  
 
 

 
The tools are accessed by Tools>Log File depth Shift  and Tools>Log Splice,  as 
shown above.  These will be discussed separately. 
 

Log File Depth Shift 
 
On selecting the option,  the log file select menu will be presented,  the user should 
select the log file (*.RDF) that is to be processed.  After selection,  the screen will 
appear as below. 
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The selected filename and path will appear in the window “Selected File name”.  Note 
the button annotated “Save Safe Copy To C:\ClientsLogs\bh_test.SFT”.  Pressing this 
will create a safety copy of the log file with the same name but extension .SFT in the 
same directory,  in this case “C:\ClientsLogs\bh_test.SFT”.  This allows a recovery 
position if some processing errors occur. 
 
Also will appear the depth wheel parameters,  the circumference and the number of 
pulses per revolution.   These can be edited and applied by pressing “Write Edit 
Values”. 
 
The whole log can be shifted in depth by entering the depth shift required in the 
“Enter Depth Shift” box,  always entering a positive number,  and selecting if the new 
log file needs to be deeper or shallower. Press “Apply” will cause the shift to be 
made. 
 

Log File Splice 
 
Often two runs are made in the same well,  the second run being deeper.  The log files 
obtained from these different runs can be splice to create a single log file that can be 
replayed.   
 
To achieve this,  select Tools>Log Splice.  The screen will appear as below; 
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Here the user can browse for the two input files File A and File B.  The file to be 
created,  the concatenation of File A and File B,  is named by entering the path in 
name in the lower text box. 
 
The depth at which the splice is to be made is chosen and entered into the “Splice 
Depth” window.  Pressing “Start Splice” will merge the File A and B into the output 
file.  The header created for the output file is copied,  without modification,  from File 
A.HDR. 

 
 

Density Logging With The GeoVista System 
 
The GeoVista logging system is capable of  producing density logs,  from density 
sondes,   calibrated in grams per CC while logging.  The methods employed are 
described here. 
 

Enabling & Disabling The Density In Grams\CC 
 
Note that some applications require that raw CPS be displayed on the log.  This can be 
achieved by switching OFF the density function formers.  
 
Locate the file \gvsystem\gv1sonde.ini and open it with notepad.  Search for the CDL 
sonde entry and locate this section; 
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The lines of interest have been highlighted.  In this application the LSD has the 
density calibration into grams\CC enabled (Apply LS density Algorithm# 1=Yes) while the 
SSD detector will not be converted into grams\CC (Apply SS density Algorithm# 2=No). 
 
Any combination of Yes & No is allowed.  Note that after a log is recorded,  then 
these (highlighted) phrases appear in the header file.  These can then be edited to 
replay the log in different formats. 

Master Calibration. 
 
The first step in setting up the system is to generate the master calibration count rates.  
These are the count rates obtained in the test fixtures ,  Aluminium and water,  
obtained from the master sonde and source.  
 

Curve#1== 
Curve# 1=LSD 
Depth Offset# 1=0.20 
Unit Name# 1=G\CC 
Packet Length# 1=2 
Frequency Based# 1=Yes 
TimeBase Channel# 1=No 
Scale# 1=Linear 
LH_Value# 1=0 
RH_Value# 1=20 
LH_POS# 1=TK2 
RH_POS# 1=TK3 
Coding# 1=8388863 
Curve Width # 1=0 
FW# 1=0.15 
Apply LS density Algorithm# 1=Yes 
Calibration Routine# 1=0 
Curve#2== 
Curve# 2=SSD 
Depth Offset# 2=0.08 
Unit Name# 2=G\CC 
Packet Length# 2=2 
Frequency Based# 2=Yes 
TimeBase Channel# 2=No 
Scale# 2=Linear 
LH_Value# 2=0 
RH_Value# 2=20 
LH_POS# 2=TK2 
RH_POS# 2=TK3 
Coding# 2=16711680 
Curve Width # 2=0 
FW# 2=0.15 
Apply SS density Algorithm# 2=No 
Calibration Routine# 2=0 
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For the moment,  assume that only one logging source and sonde available .  The 
procedure is to nominate the density sonde as the master sonde.  This sonde is then 
placed,  in turn,  onto the Aluminium block and into the water vessel,  with the source 
attached.   
 
The count rates for both long and short detectors should be accumulated over a 300 
second period and recorded.  The “Average” button on the diagnostic screen can be 
used for this. 
 
These are entered into the system file GV_SYS.INI located in the \gvsystem directory 
on the logging computer.  Open this file with an ASCII editor and locate the section as 
shown here; 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Then enter the values noted into this file in the locations shown below; 
 
The Count Rate Measured; Enter Into; 
LSD in water calibrator LS_WaterPoint 
LSD in Aluminium LS_AluminiumPoint 
SSD in Water Calibrator SS_WaterPoint 
SSD in Aluminium  SS_AluminiumPoint 
 
 
Note that the values of the densities of the calibration points used (Aluminium and 
water) are also entered into this file.  The values shown are normally correct for the 
block supplied,  but may be changed.  For example,  if the user wished to use 
Magnesium instead of water,  the Magnesium values can be substituted for the water 

 
[Density Algorithm Coefficients] 
SS_A=25.0292 
SS_B=-2.8896 
LS_A=5.4787 
LS_B=-0.6359 
 
LS_WaterPoint=1109.0 
LS_AluminiumPoint=79.0 
SS_WaterPoint=4060.0 
SS_AluminiumPoint=2270.0 
 
LS DeadTime (microseconds)=1.1 
LS Dead Time CorrectionON=Yes 
 
SS DeadTime (microseconds)=1.1 
SS Dead Time CorrectionON=Yes 
 
Aluminium Density(gm\cc)=2.70 
Water density(gm\cc)=1.02 
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values. Do not change the text to the left hand side of the “=” sign,  just enter the 
Magnesium values and enter 
 

Aluminium Density(gm\cc)=2.710 
Water density(gm\cc)=1.7 

 
Where 1.7 gm\cc is the density of the Magnesium block available.  The fact that the 
text incorrectly describes the second block will have no impact on the results. 
 

How Is The Master Calibration Applied? 
 
When the GeoVista software is started,  the values in this section of GV_SYS.INI file 
are read and coefficients calculated.  These coefficients are used to calculate density 
from the measured count rates,  one set of coefficients for each detector. 
 
The coefficients are used as; 
 
LSD Density = LS_A + LS_B * log(LSD Count Rate)……………….. (1) 
 
SSD Density = SS_A + SS_B * log(SSD Count Rate)……………….. (2) 
 
Where both results are in grams per CC.  Note that the values of A and B for both the 
long and short detectors are written to the GV_SYS.INI file.  These are for 
convenience only and are never read by the software.  Note that throughout the 
density calibration,  natural logarithms are used rather than base 10 logarithms. 
 
 

Sonde Normalisation 
 
Not all sondes are identical,  and sometimes different logging sources are used.  To 
get around this and still use the same set of coefficients (LS_A,  LS_N,  SS_A and 
SS_B) for each sonde,  the sonde in use is normalised to match the master calibration 
data.  This is achieved using the usual sonde calibration routines offered by the 
GeoVista software.  This procedure is started from the diagnostic logging screen by 
placing the mouse cursor over the required channel and clicking the right mouse 
button.  The calibration screen will then be displayed. 
 
On this screen is a “Density Calibration” box with two options,  “LS Detector” and 
“SS Detector”.  Clicking one of these will preload the calibration points in the 
“Calibration Point” windows with the master calibration values that have been read 
from the GV_SYS.INI file.  This is a convenience so that the user does not have to 
remember awkward numbers. 
 
With the sonde in the appropriate calibration fixture,  start the calibration point 
acquisition in the usual manner. Select 100 seconds for the average period. 
 
On completion of the two points,  press “Calculate” and “Save”.  The coefficients to 
normalise the current sonde to the master sonde count rates will then be written.  
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Of course,  if this sonde is the master sonde then the count rates should be similar. 
 
A sample screen is shown below where the LSD normalisation procedure has been 
initiated. 
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Data Flow While Logging 
 
A schematic of the data flow while logging is shown below.  Details such as depth 
offsets and filtering are not included for clarity,  just those points pertinent to density 
logging are shown. 
 
        Normaliser                                           Function Former 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Input: Raw CPS   Input: Normalised CPS 
 Output: Normalised CPS  Output: grams per CC 
 Equation Applied;   Equation Applied: 

Normal = A0 + A1 * CPS  Density=A + B*Log(CPS) 
 
 
 
There are two stages,  the normaliser and the density function former.  The use of the 
coefficients can be clearly seen.  There are two identical processes in operation,  one 
each for the short spacing and long spacing. 
 
On the diagnostic screen,  the display for the SSD and LSD will be in CPS when the 
“calibrate” function is not selected.  When pressed,  the software will automatically 
apply the normalisation coefficients and density in gm\cc. 
 

Notes On The Calibrators. 
 
The large Aluminium (250mm * 250mm * 500mm) calibrator supplied by GeoVista 
has a cut out in the top surface which accommodates the sonde.  Also a clamp at the 
rear of the block to hold the sonde firmly in place.  This should be adjusted so that 
there is no movement of the sonde.  The surface of the block should be cleaned before 
use.   
 
The size of this block is such that it is effectively infinite (that is,  if you made it 
bigger the count rates would not change) and is a master calibration point. 

10 100  1000  10000 
                   CPS 

3 
 
2 
 
1 

Gm\cc 

Master Sonde 
CPS 

Normalised 
CPS CPS 
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The water calibration tank should have at least 500mm water depth and 500mm of 
water in front of the detector assembly (the side away from the caliper arm).  There 
should be at least 300mm of water behind the sonde.,  but ideally it would be 
symmetrical. 
 
An optionally supplied calibrator is the light weight field jig.  This is easily handled 
and can be placed onto the sonde by one person.  This is not a calibrator,  but rather a 
check jig to determine if some sonde failure, for example,  a broken crystal,  has 
occurred since the last master calibration. 
 
The procedure is to perform the master calibration then place the sonde in the field jig 
and record a time log.  Ideally,  the sonde should be supported off the ground and the 
detector assembly facing upwards.   
 
In the field the sonde is placed in the jig and the response compared with that obtained 
in the shop.  Any significant deviation indicates that there is a problem with the sonde 
which should be investigated. 
 
 
 

Version 2 Logger & Sonde Communications Control 

 
In March 2008,  GeoVista released the version 2 logger.  From the users point of 
view,  the main advantage is the ability to control the sonde communication 
parameters.  This allows for correct operation on longer logging cables. 
 
With the earlier generation loggers,  the main reason that communications was 
compromised on longer cables was that the sonde address pulses were attenuated 
leading to an incorrect address reception in the sonde. 
 
To fully utilise these new functions,  an oscilloscope is required,  although the 
improvement is so significant that successful communications is usually achieved 
without this. 
 
Presented here are some sample waveforms recorded on 2,600 metres of 3/16” 
monocable.  An oscilloscope was connected at the cable head end and the waveforms 
recorded. 
 
To utilise these functions,  GeoVista Platform Logger software Version 6.21 or higher 
is required.  This version will operate with all GeoVista USB loggers,  the 
communication control options will not be available on earlier loggers. 
 
Selection Of The Control WIndow. 
 
Access is via the existing tools menu and is selected as; 
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This will open the control window; 
 

 
 
 
Here are presented typical values that will operate correctly in most situations.  On 
shorter cables,  selecting “Low Drive” may be advisable. 
 
Below is shown the sonde address reception with different settings.  The settings are 
recorded below the scope shot. 
 
It should be noted that for good reception all the positive peaks need to cross the 
threshold of 1 Volt,  seen as the horizontal blue line. 
 
All the parameters discussed here are stored in the logger and are recalled when the 
software is restarted. 
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Scope Shot  Address Pulse Width = 40  Address UnderDrive = 0.  High Drive 
selected 
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Scope Shot  Address Pulse Width = 20  Address UnderDrive = 0. High Drive 
selected 
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     Scope Shot  Address Pulse Width = 20  Address UnderDrive = 0.  Low Drive 
selected 
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Scope Shot  Address Pulse Width = 60  Address UnderDrive = 0.  High Drive 
selected 
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Scope Shot  Address Pulse Width = 60  Address UnderDrive = 10.  High Drive 
selected 
 
 

Set Current Limit 
 
This allows the user to set the value at which the sonde power supply,  in the logger,  
will trip out at.  A visual indication is given when the sonde power trips.  This value 
can be adjusted up to a maximum of 250 milliamperes. 
 

Set Threshold 
 
At surface,  the sonde pulses are discriminated against a DC level.  This can be 
controlled from here.  The value shown will operate in most cases. 
 

Software Modification Record 
 
5.78 March 2004  added the exp function in user functions 
 
5.80 July 2004 added wiggle display on sonic replay and allow resizing of the display               
on replay. Also added the logarithmic grid display option on replay (only) 
 
5.81  added the response to the shaft encoder error from the latest boards WDUA4 
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         added the depth shift of the sonic files to the log edit menu 
         modified the SGAM Ascii file format.   
         allowed creation of a LAS file with only those curves currently displayed.                     
         Added GET DEPTH and GET TENSION to the user functions 
5.82  April 2005  Added the SEG2 file format export of full wave sonic files 
         Also forced calibration to be ON when the diagnostic screen is enabled 
 
6.26 with new sonic completed.  Dec 2008 
6.27  Added the scaling to the SEG2 wiggle output,  controlled from the GV_SYS.INI 
file A0 & A1 
6.28  Fixed the problem where zero CPS on the long spacing density caused a zero 
density to be output. 
6.32 Added the Array Sonic sonde.  Fixed problem where it only wrote the first 3 of '  
6.33  Added function ExportSngSonicNormalisedWiggleAsSEG2Format to conform 
with WellCad requirements for equal depth samples and equal depth interval for 
SEG2 files 
6.34 added the LAS auto creation and the "double click on RDF\HDR" to open in 
replay mode 
6.35  Added the DeadTime controls to the fullwave sonic sonde. 
6.36. Added user entered depth offset when creating AutoLAS file ' from user 
supplied Excel_CSV file when fields match. 
6.37  Added writing the SGAM windows into the header.  Also preselected the temp 
stab flag to be on 
6.38  Fixed some of the automatic LAS file generation bugs 
6.39 Allowed the Verticality plot when the VECS sonde was used 
6.40 Corrected the incorrect filename extensions applied to the export of SEG2 & 
Ascii files. 
6.41 fixed the log(0) on the density calculation routine 
6.42  added the CalcVert function to the userfunctions. 
6.43 Added the K U Th calculation on the diagnostic screen and saving to the Ascii 
file recorded. 
6.44.  Added winch parameter selection. Fixed bug where the Cypress USB chip 
logger failed with SGAM 
6.45  added the Gyro functionality.   
6.47  Added the GvNSonde.ini functionality 
6.48.  Added the HRSG sonde.  Also the FEET flag in the SEG2 file generation 
6.49 to fix some remaining HRSG issues.  Added the change depth units to file depth 
shift toolbar 
6.50 Added the 4 receiver sonic sonde 
6.51,  corrected the SEG2 file name extension as mentioned.  Added the log 
disclaimer to the header print out 
6.52  Added the extras for  the ASNC sonde 4 * RX version 
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Manual Modification Record 
 
To Version 5.0  June 2003.  Added more screen shots & improved index. 
 
To Version 5.1  September 2003.  Added Video typewriter description 
 
To Version 5.2  Feb 2004.  Included density manual. 
 
To Version 5.3  July 2004.  Included comments on sonic file Ascii export 
 
To Version 5.4  May 2005.  Included comments on sonic file SEG2 export 
 
To Version 6.0  March 2008.  Included the cable communications description. 
 
To Version 7.1 August 2009  Included the Automatic LAS generation & Windows 
association. 
 
To Version 7.2 March  2011  Added the header entries association with LAS fields. 
 
To Version 7.3 March  2012  Added the log disclaimer section. 
 
To Version 7.4 July 2012  Added the differential tension display section. 
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